Allium.

Migration Guide
Migrating from Autodesk Eagle™
to Altium Designer®




Transitioning from Autodesk Eagle PCB to Altium Designer

For the purpose of this migration guide we are going to focus on importing Eagle PCB Designs, if you
require other files migrated, please refer to their specific guide.
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Preparing to Migrate Your Legacy Data

Never forget that migration of data follows the “garbage in.... more garbage out” principle. So, we need to
consider four distinct phases of the process, this is best shown in the flow diagram below: -

Step 1: Prepare Original Data - Pre-Translation Tidy Up

It is prudent to clean and tidy your design within your legacy system before trying to export. We’ve put
together a checklist to help you: -

> Schematic considerations

Does this design have single pin components representing power objects?

Connectors are represented as one-gate-per-pin with over 256 “gates”

Keep a note of the ambiguous connectivity in the design (For example - multifunctional
pins, hidden pins, or implicit connections).

Make sure to understand which nets in the design are local(defined at the document level)
in nature.

Do the schematic symbols call up the correct PCB footprints?

Does the schematic match the PCB?

> PCB considerations

A large number of graphical objects like mechanical drawing or non-ECO-registered
drawing primitives need to be assigned in the documentation layers.

Make a note if the design has star point earth.

Deliberate DRC violations (For example, allowed short circuits and net-ties).

Objects extending beyond the environment

Knowledge of correct PCB layer assignment is required in order to map the imported layers
with existing layers in Altium Designer.

Do the auto-named nets match with the schematic?

> Library considerations

Schematic symbols matching with PCB footprints

Correct supply chain information and BoM parameters

Associated 3D models cannot be imported for eagle-based libraries and one can import the
respective STEP models in Altium later on.

Correct representation of custom pads, copper shapes, solder mask and resist.
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Step 2: Save Data in a Suitable Format

Supported Version and File Formats

The following table details the versions of all Eagle design formats that can be migrated into Altium
Designer. Note that this list is updated all of the time, so please check with us for specific systems and
versions before undertaking migration.

Eagle 6.4.0 (*.BRD)
SCH Eagle 6.4.0 (*.SCH)
LIB Eagle 6.4.0 (*LBR)

Altium Designer's EAGLE Importer is able to import EAGLE design files saved with EAGLE version 6.4.0
(or later). These are XML-format in nature — EAGLE binary-format design files cannot be imported directly
using the EAGLE Importer. For these older, binary version design files, it is advised to save them in this
later (XML) format, through your EAGLE software, before attempting to import them into Altium Designer.

PCB files translate as follows:

e Eagle PCB Design files (*.brd) translate to Altium Designer PCB files (*.PcbDoc).

e Eagle SCH Design files (*.sch) translate to Altium Designer PCB files (*.SchDoc).

e Eagle Library Design Files (*.lbr) translate to Altium Designer PCB Libraries and Altium Designer
Schematic Libraries (*.PcbLib & *.SchLib).
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Step 3: Import Data into Altium

Using the Import Wizard for Eagle Design Files

The Import Wizard can be launched from the Altium Designer File menu. Choose the EAGLE Projects
and Designs from the list of file types as shown in the screenshot below. On the “Importing Eagle Design
Files” screen, click the Add button to choose the Eagle design files. Multiple files can be translated at the
same time. Step-by-step instructions on how to use the Import Wizard are to follow.

Q

Import Wizard

Select Type of Files to Import

Select the type of files you wish to import from the list below,

File Types Drescription
95E DDE Files %95E DDB
Allegro Design Files
STAR Designs and Libraries 2
CircuitMake Schematics and Libraries Files KT), CircuitMaker User Libiraries (*.LIB), Circu
DxDesigner Designs and Libraries Files DxDesigner Designs, Dxl gner Libraries
EAGLE Prajects and Designs EAGLE Files (*.5CH, *.BRD, *.LBR)
Mentor Expedition Designs and Libraries Mentor Expedition Files
Mento (Designer Prajects and Designs Mentor
Orcad Designs and Libraries Files Orcad De
Orcad nfiguration Files and Libraries
PADS ASCIH Design And Library Files PADS A
Orcad and PADS Designs and Libraries Files Orcad De
P-CAD Designs and Libraries Files P-CAD Schematic
Zuken CR-5000 Design Files Fuken CR-5000

Get More Importers... Cancel

Starting the Import Wizard for Eagle Design files

You can also drag your Eagle Design Files into Altium Designers Projects Panel, this will automatically
launch the wizard in Eagle Import mode.
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Step-by-Step Import Instructions on Importing Eagle Design files.
« Start the Import Wizard with File » Import Wizard

Import Wizard

rd will help you convert your files from other vendors to Altium Designer

Cancel

» Select Type of Files to Import—>Eagle Projects and Designs
Select Type of Files to Import

Select the type of files you wish to import from the list below.
File Types Description
SE DDE Files
legro Design Files
([ }, Circuithaker User Libraries [*.
igner Designs, DxDesigner Libraries
EAGLE Files [*.5CH, *.ERD, *.LER)
Mentaor
Mentaor 3

CircuitMa chematics and Libraries Files
D igner Designs and Libraries Files

EAGLE Projects and Designs

Mentor

Mentor

Cancel
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* Add the file(s) to be translated. In this case, ‘MKR1000.brd’ and ‘MKR1000.sch’ have been used.

EAGLE Import Wizard

Importing EAGLE Design Files
Choose the EAGLE design files to import.

Add EAGLE design files to the list below for processing.
To import @ pch design, add EAGLE pcb design archive [.brd)
To import a schematic design, add EAGLE schematic design archive {.schj

EAGLE Design Files

Eemove

Cancel

You can add as many .brd and .sch files at this point, however, if you add files of a different file name,
separate projects will be created. Once you have chosen your design files, the next screen will allow
you to import any library files you have.
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Using the ‘Reporting Options’ page map the layers for the PCB by assigning a suitable layer type and
layer name to be Signal/Solder/Paste/Silkscreen/Mechanical

EAGLE Import Wizard

Reporting Options

Jse the following options to control the reports manager.

Back
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* Use the 'Output Project Structure' page to enable or disable the settings for logging all errors, all
warnings, and events respectively. You can also set up Schematic Settings here.

EAGLE Import Wizard

Output Projects

Review the output project structure and specify the output directory to

import the files.

General Settings

~ Log All Errors ~ Log All Warnings

PCE settings

Generate 3D body By layers

Schematic settings
< Recognize powerports Power port designators
¥ Recognize ports Port designators

lgnore document templates

= Hide default sheet template

Library settings

* A preview of the files being translated and their output directories are then shown. You can change the

main output directory at this point if desired.
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" Log All Events

tKeepout;tDocu;tCream;tStop

Create bus entry

~ Do not translate hidden net names

Cancel




EAGLE Import Wizard

Executing Import Process

The imported structure is displayed below,

Output Directory : ChUsers\MKRTO0D0 reference)]

COutput Structure
4 MER1000.PrjPch
4 ChUsers\MKR1000-referencet\MER1000.sch
MEKR1000_0.SchDoc
MEKR1000_1.SchDoc
4 ChUsers\MKR1000-reference\MER1000.brd
MER1000.PchDoc

* Click the final Next button and the Import Wizard will take care of the rest.

EAGLE Import Wizard
Finish

Altium Designer is now ready to import the selected libraries and designs.

Processing Project: MER1000.PrjPch
ChilUsers\MKR1000-reference’\MKR1000.brd

Create PCE File: C:\Users\MKR1000-reference’\lmported MER1000.PrjPcb\MKR1000.PcbDoc
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» Congratulations, your design has now been imported into Altium Designer! Follow the Post Import Tidy
Up checks to ensure the design has been fully checked and verified.

Altium Designer

w B
Projects
=8 wR o
Snap: 0.1mm Hotspot Snap: 0.203mm

ct Group 1.DsnWrk
4 1 MKR1000.PriPch
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gear button at the top right corner and Preferences>Schematic>Graphical Editing disable the

| Q ‘ In case the imported text on schematics is inverted after design import, simply click on the
’ option ‘Display Strings as Rotated’. An example is shown above.
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Step 4: Post Import Tidy Up

We’ve put together a verification checklist for you:-

> Physical check

e View » Fit Document
e Board shape and cutouts

> Electrical check
e Netlist

> Rules

Have all rules been imported

DRC check

Check settings for polygons - Island removal, min primitive size
Thermal reliefs, direct connect

Check power plane settings

Power plane Pull-back

Solder mask, Paste mask rules

Via Tenting

Testpoint assignments

> Power check

e Nets
e Planes
e Polygons

> Documentation check

e layers
e Text/Strings
e |legends

> PCB reports

e Number of components/nets
e All nets routed

Reference Tech-Doc - Post Import Consideration
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Getting Help

Main article: Documentation and Help

The best way to learn is through doing, Altium and Altium Designer provide a number of ways to help you
do that:

e Press F1 with cursor over any object, editor, panel, menu entry, or button to open a
brief description in your web browser

e Use shortcut Shift+F1 while running a command for a list of shortcuts you can use
in that command.

03mm
referred] [Via-Size From: Rule Preferred][Thru 1:4] Gloss: Strong
k[0.3mm x 1.943mm]
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Image illustrating pressing Shift+F1 during active interactive routing command

e Altium Designer Shortcut Keys

e Search the Altium Documentation, on the Altium website.

e Visit the Video Library where you can watch over 150 short training videos, each
detailing the exact steps needed to complete a task.

e Activating & Managing Your Altium 365 Workspace
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See Also

Below are references to other articles and tutorials in the Altium Designer Documentation Library that talk
more about the conceptual information as well as walk you through specific tasks. Remember, you can

also browse through the Help contents, and use F1 and What's This at any time in a dialog for more
details.

e For more PCB project options, refer to the tutorial, A Complete Design Walkthrough with Altium
Designer

e For a tutorial that steps you through all the basics of creating components, read A Look at
Creating Library Components.

e For a tutorial that steps you through all the basics of editing multiple objects, read Editing
Multiple Objects.

A great place to start your journey through all the new possibilities with your Altium Designer installation.
On the top left of Altium Designer you can find the Help » Exploring Altium Designer link
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Exploring Altium Designer |y
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From here, you can easily access the Documentation where the “Getting Familiar with the Altium Design
Environment” category will ease your beginning into using Altium.
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Address: 4225 Executive Square, Level 7
La Jolla, CA 92037, USA

Phone: +1 858-864-1500

Moving to Altium Designer from Autodesk Eagle


http://www.altium.com

